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Tomosynthesis

System overview

Indication for Use 0

The MAMMOMAT Inspiration with Tomosynthesis Option is indicated for acqui-
sition of 2D as well as 3D digital mammography images to be used in screening 
and diagnosis of breast cancer.

Each screening examination must consist of CC and MLO views in:

o 2D image set or

o 2D and 3D image set.

Note: The screening examination may consist of 2D FFDM images set with or without 
the 3D image set. 

Caution: Federal law restricts this device to sale or on order of a physician.

Please be aware that this Operator Manual Tomosynthesis is just one option.
Only the complete manual is valid:
- Operator Manual - MAMMOMAT Inspiration system
- Quality control manual
- syngo Operator Manual - syngo VE33A
- Tomosynthesis Option
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System description 0

MAMMOMAT Inspiration and MAMMOMAT Inspiration PRIME Edition are 
supporting the Tomosynthesis Option. All descripted features of this user manual 
are available on both versions.

With tomosynthesis, three-dimensional information can be obtained by taking 
exposures from different angles. This significantly reduces the tissue overlap 
problem which limits diagnosis in conventional mammography. Tomosynthesis is 
displayed and controlled at the workstation.

In tomosynthesis, the X-ray tube rotates in a defined angular range. During the 
acquisition, several X-rays are taken from different directions. Each of these 
single exposures is taken with a very low dose. Due to the different acquisition 
directions, the set of 2-dimensional X-ray images contains the 3D information of 
the object, allowing the volume of the breast to be reconstructed by appropriate 
software algorithms and visualized in the form of slice images.

During tomosynthesis acquisition, the swivel arm of the MAMMOMAT 
Inspiration covers an angular range from +25° to -25° while 25 views are 
acquired.

Inform the patient in detail about the examination procedure, in particular about 
the time required and the automatic movement of the swivel arm.

(1) Face shield

(2) Compression plate

(1)

(2)
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Acquisition area

Tomo scan Generated data set of a definite view, consisting of raw projections and/or pro-
cessed projections and/or the slices or combinations of these.

Raw projections Single image taken during the tomo scan. 25 projections are acquired during the 
sweep of 50°, every other degree one projection. The projections are saved as 
DICOM MG objects.

Processed projections Projections acquired during a tomo acquisition, processed with OpView 2D im-
age processing for better visualization. These images are saved as DICOM MG 
for presentation.
When using 2D+Tomo-Scan the first image of the stored projections series is 
the 2D image.

25 Projections are acquired (X-ray)

Detector

- 25° + 25°
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First view First exposure during tomo scan which the swivel arm is at an angle of 0°.
When using 2D+Tomo-Scan the first image is the 2D image.

Slices Stack of images parallel to the detector surface reconstructed from projections 
with the purpose of display at the workstation monitor.

Bounding box Region of interest, describing the area that will be reconstructed. Using the han-
dles you can adjust the bounding box to the breast tissue area to be reconstruct-
ed for slices.

Reconstruction The calculation of the stack of slices (3D volume) from the projections using a re-
construction algorithm.

Reprocessing Processing of the projections and 2D image with new parameter set (OpView).
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Automatic movement
of the swivel arm

25 views are acquired in an angular range from -25° to +25°. The exposure re-
lease button on the control box or on the foot or hand switch must be pressed 
and held during all exposures.

o The swivel arm is in the 0° position.
The first view is acquired for automatic exposure control.

o Swivel arm moves to -25°, second exposure is taken.

o The swivel arm covers the entire angular range from -25° to +25° while an 
exposure is taken at every 2°.

o Swivel arm returns to the start position.

o Letting go of the exposure release button.

o The first view is displayed.

o The slices are automatically reconstructed and then displayed.

o The projections are processed and displayed.

+25°-25°

Inform the patient in detail about the examination procedure, in particular about 
the time required and the automatic movement of the swivel arm.
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Compression plate 0

The following compression plates can be used for a tomo examination:

(1) Compression plate 26 cm x 35 cm for tomo examination

(2) Compression plate 24 cm x 30 cm Low for tomo examination 

The plastic paddles can be removed, see register: System overview, page 12.
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Tomo face shield 0

A special face shield must be used during tomo examinations:

(1) Face shield

(1)

Warning

The patient's head can enter the beam path.

Unnecessary radiation exposure!

u Make sure that the special face shield is always used during a tomo exami-
nation if there is a risk that the patient's head can enter the beam path.
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System setting 0

Before beginning with the tomo examination, the appropriate compression plate 
and the tomo face shield must be attached to the MAMMOMAT.

Performing detector calibration 0

Type of calibration Your MAMMOMAT Inspiration offers a large number of different types of exam-
inations. To ensure the optimal detector settings for each type in all cases, the 
following different types of calibrations are performed:

If the difference between the detector temperature and the calibration tempera-
ture reaches 7°C or more, allow the MAMMOMAT Inspiration to warm up for at 
least 30 minutes in order to ensure optimal results in the image quality test.

Calibration intervals As a rule, the detector should be calibrated every 3 months.

The calibration should also be performed if the room temperature deviates by 
more than 7 °C from the temperature at the last calibration.

Preparing the
swivel arm

Before you begin calibration, you have to set the swivel arm up for the calibration.

u Install the 40 mm Plexiglass plate on the swivel arm so that the entire image 
area is covered.

u Move the swivel arm to the 0° position.

u Remove the compression plate.

Type of calibration Special features

CONTACT none

MAGNIFICATION without magnification table

TOMOSYNTHESIS none

Calibration is performed without a compression plate.
It is recommend that the tomosynthesis calibration be performed after 
contact calibration.
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Starting the
calibration

u Select Patient > Detector Calibration from the main menu of the 
Examination task card.
– Calibration is automatically registered.
– The Calibration subtask card is displayed.

(1) Next required step

(2) Area for selecting the type of calibration

(3) Date of the last calibration for the respective type of calibration
(if a “!” appears, the calibration is overdue)

u Click the TOMOSYNTHESIS type of calibration.

u Click Start Calibration.

(3)

(1)

(2)

When the calibration subtask is selected, the exposure parameters are 
automatically correctly set and displayed in the generator control field for each 
anode/filter combination.

→ see register: Examination, section Generator control field

Please note that for the TOMOSYNTHESIS calibration type, the calibration can 
only be repeated five times. After that the system has to be restarted.
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Calibration images When calibration is started, the Calibration subtask card for the type of calibra-
tion selected changes. The projection view to be acquired is shown in the 
Images subtask card.
At least 7 displayed exposures must be taken.

u In the Images subtask card, double-click the first projection view, if it has not 
already been activated, to release the exposure.

u Press the exposure button on the control box until all 26 exposure pulses have 
been completed. The gantry will remain in 0° position.
– Radiation is released and the first calibration image is taken.
– After the exposure is complete, the finished image is displayed in the 

image area.
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u Click Accept if the exposure is suitable for calibration.
– Windowing may be required to check image quality.
– The detector is re-calibrated on the basis of the calibration image.

Or

u Click Reject if the exposure is not suitable.
– The calibration image is rejected and a new exposure is added.

u Continue acquiring calibration images until you have produced 7 suitable ex-
posures.
– The number of accepted and rejected exposures is counted in the 

Calibration subtask card.

Ending detector calibration 0

The calibration process ends as soon as you have calibrated the detector using a 
sufficient number of suitable acquisitions (recommendation: at least 7 images).

The following message window appears:

Confirm the message window by clicking Yes to start calibration calculation.
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Calculation
successful

The following message window appears when the calculation is successful:

u Confirm the message window with OK.
– The calibration closes automatically.

u Remove the 40 mm Plexiglass plate.

You can select and evaluate the calibration results. The results are available in the 
Service menu, see the Check calibration results section in the operator manual.

Calculation
unsuccessful

The following warning window appears when the calculation is unsuccessful:

This message means that several non-functioning pixels were found during the 
calibration. This requires a system check by a Siemens service technician. 
The results are available in the Service menu, see the Check calibration results 
section in the operator manual.

u Call a Siemens service technician or a technician trained by Siemens.

Until the analysis by the service technician, clinical operation may continue if: 
- the daily checks run without errors 
- there are no visible artifacts 
- the quality authorities have no objections
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Tomosynthesis

Tomosynthesis examination

This chapter describes a typical tomo examination. The examination is controlled 
at the workstation with preset examination parameters.

→ For information about the control and display elements of the tomo examina-
tion see Section System setting, page 10. 

→ For further information on performing the examination at the workstation and 
changing examination settings, see the tab: Examination task card, page 3. 

Layout of the Examination task card 0

The Examination task card is divided into different functional areas:

(1) Menu bar

(2) Image area

(3) Stack of subtask cards

(4) Control area

(5) Status bar

(6) Generator control field

(1)

(2)

(5)

(4)

(3)

(6)
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Preparations 0

It is assumed that the MAMMOMAT has been correctly installed and started up.

u Prepare the MAMMOMAT for tomo mode.

u Inform the patient about the examination procedure.

Registering the patient 0

At the beginning of an examination the patient must be registered:
– via the RIS/Scheduler or
– manually

u To open the Patient Registration window, click this button.

u Enter the required examination data in the Patient Registration window.

u Click the Exam button.
– The Examination task card is opened.

For the first examination of the day using tomosynthesis, automatic activation of 
the first acquisition is active (Options > Auto Enable First PV), after which the 
patient's breast can be compressed.
If the breast is compressed first followed by activation of the first acquisition, 
an error message can occur. If an error message occurs, acknowledge it, 
wait 15 seconds, and continue the examination.
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Performing the examination settings 0

The settings for the tomo examination are performed in the subtask cards of the 
Examination task card.

Examination
procedure

u Select the required tomo procedure in the Procedure list.
– The projection sequence preset for the procedure is displayed in the 

PAO list.

u If necessary, select the Operator(s).

u Adjust the examination parameters, if necessary.
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Examination
parameters

u Click the Acquisition subtask card into the foreground.

u If an implant is present, then select the type of implant in the Imp list.

u Select the desired exposure technique in the Exp selection list.
– If the patient has breast implants, an exposure technique with Manual 

exposure mode must be selected.

u In the RPG (Reconstruction Parameter Group) list, if necessary select a 
reconstruction parameter, e.g.
– Standard - is used for all standard tomo examinations
– Calcification - is used in cases where an additional tomo reconstruction is 

required with a particular focus on micro calcifications
– Phantom - is used for quality control checks and/or technical measure-

ments with phantoms only

The selectable reconstruction parameters are configured by the 
application specialist.

Various OPDOSE settings for the tomo examination can be configured in the 
window Configuration of the procedure in the OPDOSE program tab card by 
local customer service.
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Positioning the patient 0

The tomo examination is intended for seated or standing patients.

Seated positioning u Use a suitable fixable chair with a rigid back rest to fix the posture of the 
patient in relation to the swivel arm.
– The breast should not be able to slip due to movement of the patient.

Caution

Swivel arm movements can cause parts of the body to be jammed or crushed.

Risk of injury!

u Ensure that the patient is positioned correctly. 

u Please note that the face shield also moves when the swivel arm moves.

u The patient's head must not lean against the face shield while the 
swivel arm is moving.
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Compressing the breast 0

Implants

Performing
compression

u Lower the compression plate with the control knob or foot switch and 
compress the breast with a force of at least 30 N to prevent the breast from 
moving.

u Patients with implants, or patients who recently have had breast surgery, 
must not be exposed to "optimized compression" OPCOMP.

All preparations for the examination must have been made before the 
compression.
The breast must remain compressed until all exposures have been taken.

Caution

If breast implants are not taken into consideration, this will lead to errors in treat-
ment and incorrect settings during the examination.

Risk of injury during compression and tomo examination!

u Ask the patient about existing implants prior to the examination. Inform the 
patient about the risks of providing false information.

u Adjust the preparation and examination of the patient accordingly 
(e.g., performing compression, system parameter settings).

Warning

Danger due to unintended decompression.

Risk of injury during decompression!

u Move the foot switches outside the reach of the patient and personnel as 
soon as the patient's breast is compressed.

Please note that a message box is displayed if the thickness of the compressed 
breast is between 80 and 100 mm:
- The image quality is limited.

Please note that a message box is displayed if the thickness of the compressed 
breast is > 100 mm: 
- Only slice images of up to 100 mm will be reconstructed.
- No slice images of more than 100 mm will be calculated.
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Acquiring exposures 0

The exposure to be taken is shown in the Images subtask card of the 
Examination task card.

(1) Tomo acquisition
During tomo acquisition, 25 exposures are released. The exposures are 
acquired successively.

(1)
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Acquiring tomo images 0

u Double-click the button for tomo exposures.
– The detector parameters are loaded.

The following settings for a tomo examination cannot be changed:

(1) The anode/filter combination is always W/Rh.

(2) The grid position is always defined to be outside the field of view.

(1) (2)(3)

Please note that the dose levels can be set individually for each breast thickness 
range. 
For tomosynthesis acquisitions, please note in particular with thicker breasts 
that the two highest dose levels (medium high, high) have longer exposure times 
that can lead to blurring.

If the emergency STOP button is pressed during a tomosynthesis examination:
- the Entrance Dose will not be correctly displayed in the image. 
- all other values (e.g. mAs-, kV values) will be correctly displayed in the image
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u Check the exposure parameters and adapt them, if necessary.
– Tomo images can be taken using the OPDOSE, AEC or 

MANUAL technique.

u Press and hold the exposure button on the control box as long as the signal is 
audible.
– The button will light up yellow during the exposure.
– Radiation is released and tomo images are acquired.

The following message appears as soon as the mAs is too high or too low:
“Calculated mAs outside valid range.
Please change to AEC mode.
At low compression thickness < 20 mm, reduce the kV in 1 kV increments.
For larger compression thicknesses > 50 mm increase the kV in 1 kV incre-
ments.”

To switch to AEC mode, select the AEC acquisition mode on the generator 
control panel.
The AEC value set previously is retained and the kV can be increased 
in 1 kV increments.

Caution

Swivel arm stops during exposure.

Unnecessary radiation exposure!

u Let go of the exposure release button.

u Turn the control knob upward for manual decompression, or perform 
decompression using the control panel or foot pedal.
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Exposure parameters
for 3D implant

exposures

Note that these figures are just suggested guideline values for the exposure. It 
may be necessary to adjust the exposures depending on the nature of the breast 
or implant concerned.

Projection view status In the Images subtask card, the individual projection views up to the reconstruct-
ed tomo data set are shown as follows:

Thickness
(mm)

Anode/filter 
combination

kV mAs 
only with function 
2D + Tomo-Scan

mAs
Tomo

20 WRh 25 50 ~100

30 WRh 26 70 ~140

40 WRh 26 90 ~180

50 WRh 27 110 ~220

60 WRh 28 120 ~240

70 WRh 29 130 ~260

80 WRh 30 140 ~280

90 WRh 30 160 ~320

100 WRh 31 180 ~360
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The first view is shown with the bounding box (1). It shows the reconstructed 
area.

Modifying the
bounding box

The bounding box should enclose the entire breast. If the bounding box turns out 
to be too small or too large, you can modify it with the cursor. 
If you click the mouse in the bounding box, the cursor changes its appearance 
and you can edit the graphic.

u Place the cursor on one of the handles.

u Increase or reduce the size of the region until it meets your requirements.

Or

u Move the region in the image. To do so, place the cursor on the contour line 
between the grab handles.

(1)
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u Click the Reconstruct... button.
– The tomo images will be reconstructed anew, see section Reconstructing 

tomo images page 32.

Status bar The status bar shows the progress of the reconstruction of slices (1) and the 
projection processing (2) in percent.

When all 25 slices/projection views have been generated, the view changes to 
the Tomo subtask card.

Please note that each parameter set from the Reconstruction 
parameter group name list has different reconstruction properties:
Standard is used for all standard tomo examinations.
Calcification is used in cases where an additional tomo reconstruction is 
required with a particular focus on micro calcifications.
Phantom is used for quality control checks and/or technical measurements with 
phantoms only.

(2)(1)

When calculating the projections, the initial acquisition is included so 
that 26 projections are processed.



Tomosynthesis
Tomosynthesis examination

MAMMOMAT Inspiration
XPW7-330.621.53.01.24 27 / 56

Image text
projection images

(1) kV value

(2) mAs value

(3) Angle of set projection view/projection angle during the exposure

(4) Focus

(5) Magnification factor

(6) Compression force

(7) Breast thickness

(8) Anode/filter combination

(9) Entrance dose

(10) Glandular dose/projection

(11) Detector ID

Image text
slice images

(1) Slice height, measured starting with the surface of the detector cover

(2) Slice thickness

(3) Glandular dose of complete scan

(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)

(1)
(2)

(3)
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Displaying/processing tomo examination 
images 0

Tomo examination images can be processed in the Tomo subtask card in the 
Examination task card. 

(1) Information bar, projection and reconstruction parameter group (RPG)

(2) Display first view (when using 2D+Tomo-Scan display 2D image)

(3) Display slice image

(4) Display projection image

(5) Play automatic movie

(6) Reconstruct tomo images

(7) Delete selected reconstructed tomo images

(1)

(2)

(3)

(4)

(5)

(6)

(7)

Subsequent acquisition must be deactivated in order to process tomo examina-
tion images.
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Display of
reconstructions

u If necessary, select a different reconstruction sequence in the list.
– The selected reconstruction sequence is displayed on the monitor.

(1) The number indicates how many reconstructions there are of a tomo scan.

If there are several exposures, you can use the arrow buttons to skip to the next 
set of reconstructions.

(1)

Please note that the number of slices depends on the compression thickness, 
compression plate, and compression force.
The compression plate can bend slightly during breast compression; as a result, 
there could be differences in the compression thickness shown on the digital 
stand display and the AWS monitor. The upper reconstructed slices do not con-
tain real breast tissue.
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Displaying tomo images 0

You can toggle between the different images. 

First view Exposure taken at an angle of 0°.

u Select View > First view in the menu bar.
– The first view is displayed.

Or

u Click the Single view button in the Tomo subtask card or in the scroll bar.

Or

u Use the shortcut Ctrl + F1.

Projection images 25 views from different angles from which the slices are reconstructed. 

Note that the acquisitions were taken with a low dose and restricted 
image quality.

u In the main menu select View > Tomo Projections.
– The projection views are displayed.

Caution

The evaluation of distances in projected tomo images can be inaccurate.

Incorrect measurement results, incorrect diagnosis.

u Do not use projected tomo images to perform critical measurements.
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Or

u Click the Tomo Projections button in the Tomo subtask card or in the 
scroll bar.

Or

u Use the shortcut Ctrl + F2.

Slice images Reconstructed slices (3D volumes) from which projections of different recon-
struction algorithms (RPG) are possible.

u In the main menu select View > Slices.
– The slice views are displayed.

Or

u Click the Slices button in the Tomo subtask card or in the scroll bar.

Or

u Use the short cut Ctrl + F3.

Note that projection acquisitions cannot be sent to the Filming task card.
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Reconstructing tomo images 0

For better visualization of details, tomo images can be reconstructed with differ-
ent reconstruction parameters, see page 18.

Reconstructing
images

Reconstructed images are displayed in the Tomo subtask card and in the 
Patient Browser.

u Click the Reconstruct... button.

Or

u Click on the image with the right mouse button.
– A selection window appears.

u Select Reconstruct Tomo Scan... in the popup menu displayed.
– The Reconstruction of scan dialog box is displayed:

u Select a reconstruction parameter from the Reconstruction parameter 
group name list. e.g.
– Standard - is used for all standard tomo examinations
– Calcification - is used in cases where an additional tomo reconstruction is 

required with a particular focus on micro calcifications
– Phantom - is used for quality control checks and/or technical measure-

ments with phantoms only

Caution

The specific Reconstruction parameter group name for calcification is focus-
ing on micro calcification.

Decreased perceptibility of low contrast information of the breast tissue!

u Use Standard Reconstruction parameter group name for all standard 
tomo examinations in addition to calcification parameter.
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u Click OK.
– The tomo images will be reconstructed anew with the selected reconstruc-

tion parameter.

The list in the Tomo subtask card shows the new 3D volume from the recon-
structed slices (e.g. TOMO L-LMO, Calcification, Diagnosis).

Please note that in some cases it might be necessary to adjust brightness/con-
trast (or window width and window level) manually each view.
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At the same time, a new series is saved and displayed with the selected recon-
struction parameter in the Patient Browser.

u Click Cancel.
– The Reconstruction of scan dialog box closes.
– The tomo images remain unchanged.

With each additional reconstruction the data volume increases considerably. 
Therefore, you should save only those reconstructions that are really needed.
Before closing the examination, reconstructions that are not required should be 
deleted.
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Deleting
reconstructed images

You can delete reconstructed images using the pop-up menu or the Delete 
Reconstruction button.

Pop-up menu:

u Click the Slices button in the Tomo subtask card.
– The slice views are displayed.

u Click on the image with the right mouse button.
– A selection window appears.

u Select Delete Reconstruction in the popup menu displayed.
– The following message window appears:

u Click Yes to make the changes.
– The stored series with the selected reconstruction parameter in the 

Patient Browser are deleted.

Or

u Click No if you don't want to make the changes.
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Button:

u Click the Slices button in the Tomo subtask card.
– The slice views are displayed.

u Select a reconstruction e.g. TOMO L-LMO, Standard, Diagnosis from the list.

u Click the Delete Reconstruction button.
– The following message window appears:

u Click Yes to make the changes.
– The stored series with the selected reconstruction parameter in the 

Patient Browser are deleted.

Or

u Click No if you don't want to make the changes.
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Playing back motion images (movie/cine) 0

Abnormalities in the images are generally easier to detect if you view the images 
in quick succession like a movie. The Tomo subtask card provides a function for 
fast, automatic scrolling through the images of a series. 

Layout and
display mode

u In the menu bar, select the stack display (View > Slices) to view a series as 
a movie.

u Select a large enough layout so that you can see all details. 
Recommended layout:
– 1 : 1 

The movie takes up the whole screen.

During playback of the movie, data sets should not be corrected or rearranged. 
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Automatically playing back a movie 0

If you want to ensure a constant playback speed, you can have the movie played 
back automatically. In this mode you can change a number of settings for movie 
playback.

Starting the movie

u Click the Movie Properties button.
– The Movie Properties subtask card is displayed.

In the Movie Properties subtask card you can:

o Exclude irrelevant first/last images

o Pause and restart the movie

o Change the playback speed and direction

Excluding first/last
images

u Use the spin boxes From and To to specify which images are to be included 
in the movie.
– In this way, you can exclude irrelevant first and last images. This setting 

can not be changed while the movie is being played back.

Pausing the movie,
scrolling forward and

back in steps

u Click the Stop button to pause movie playback.
– Scroll through the image stack step by step using the scroll bar or the 

dog ears.



Tomosynthesis
Tomosynthesis examination

MAMMOMAT Inspiration
XPW7-330.621.53.01.24 39 / 56

Playback speed and
direction

u Select a speed from the list.

Or

u Enter a playback speed using the spin box next to Frame rate.

Or

u Select a playback speed and direction with the slider:
All the way to the right – fast forward
Right center – slow forward
Center position – freeze frame
Left center – slow backward
All the way to the left – fast backward

Or

u Change the playback direction by clicking the Forward/Back button.

u Click the Yoyo option.
– When the movie has reached the last frame in forward playback mode, 

it will wind back to the first frame and then advance again to the last 
frame, etc.

Or

u Deselect the Yoyo option to play the movie back in a loop. 
– Once it has reached the last frame, the movie will start at the first frame 

again (loop).

u Click the Show graphics option.
– The graphics inserted will be shown as part of the movie.

Or

u Deselect the Show graphics option.
– The graphics inserted will not be shown as part of the movie.

u Click the Show Curve option.
– The curves inserted will be shown as part of the movie.

Or

u Deselect the Show Curve option.
– The curves inserted will not be shown as part of the movie.
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Additional notes on the tomo examination 0

With the projection and slice views you can query the exposure data of an image.

Correcting tomo
image information

Correcting tomo image information, e.g. changing L-CC to R-CC, is not possible 
after closing an examination or using Reenter examination.

If, however, you do attempt to correct the image information using this function, 
please note the following:

If you reenter an examination and correct a tomo image, as described below, an 
error message appears:

u Click on the Reenter examination button.

u With the right mouse button, click on the subtask card Images for the relevant 
image.

u Select the Correct entry.
An error message appears.

Acknowledge the error message 26 times and continue working.
A system restart is not required.
The tomosynthesis image has not been corrected.

You must use PACS to retrospectively correct tomo images.
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Correcting projection views 0

The exposures displayed in the image area must correspond to the planned pro-
jection views. If there is a discrepancy, a subsequent correction will be neces-
sary.

Reprocessing u Right-click the relevant image in the Images subtask card.
– A popup menu is displayed.

u Select Reprocess....
– The projection images (or 2D image of the 2D+Tomo-Scan) will be repro-

cessed with the changed to 2D parameters.

Correction u Right-click the relevant image in the Images subtask card.
– A popup menu is displayed.

u Select Correct....
– The Correct projection view dialog box is displayed.

Caution

If the wrong breast side or an unintended view was acquired, the image will be 
saved under an incorrect projection view.

Incorrect diagnosis or incorrect treatment possible!

u Check that the correct projection view is assigned to the image and 
correct it, if necessary.
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u Select the correct projection view in the New projection view window.

u Select a reconstruction parameter from the Reconstruction parameter 
group name list.

u Click OK.

u Click Yes to make the changes.
– All available exposures are reconstructed and displayed in the changed 

view.
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Adding projection views 0

In the protocol control (Images subtask card) you can modify the projection views 
preset in the selected procedure as well as their number and sequence for the 
current examination.

Depending on the selected projection view (scout exposure/first stereo expo-
sure/specimen exposure), the projection views can be modified, added, inserted 
or deleted, e.g.:

Adding a projection
view

u In the Images subtask card, right-click on a projection view or on an empty 
view in order to insert a single image or scan.
– A selection window appears.

u Select Add > Single in the popup menu displayed.
– The following selection window appears.

u Select a single projection view from the list.

Or

u Select Add > Scan in the popup menu displayed.
– The following selection window appears.

u Select a projection view from the list box.

The selection list can be configured in the Projection Name tab card, see tab: 
Configuration.
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Or

u Select Add > Modified Views for special projection views.
– The Modified Views window opens.

u If necessary, define special settings for the desired projection view in the 
upper window area.
– The list of projection views (lower box area) is restricted to the views that 

fulfill the selected criteria.

u Select the desired projection view and confirm by clicking OK.

The new projection view is added to the Images subtask card.
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Creating a 2D + 3D exposure 0

The function 2D + Tomo-Scan produces a conventional 2D exposure and a com-
plete tomo scan during an exposure.

u Before the start of the examination, in the main menu select 
Options > 2D + Tomo-Scan.

u Double-click the button 2D + 3D Exposures.
– The detector parameters are loaded.
– The following exposures are created:

2D exposure (single image)
Projections
Reconstructed layers

The 2D image is stored in the projection series.
During one examination only 2D + 3D exposures can be performed in a scan, 
or 2D and 3D in various exposures.

In the function 2D + Tomo-Scan the indicated glandular dose corresponds to
– the dose applied during the 2D exposure, in the case of a 2D exposure
– the dose applied during the entire scan, in the case of tomo slices
– the dose applied during the single projection, in the case of projection 

views
– in the case of manual 2D + 3D mode:

the set mAs value corresponds to the mAs value during the 2D exposure
the mAs value for 3D is twice as high
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When using the 2D + Tomo-Scan the 2D exposure is always done with the Grid 
Position In, even if the user has selected the option Grid Position Out in Ad-
vanced dialog box.

Avoid interrupting the radiation release during a tomosynthesis examination 
when using the 2D + Tomo-Scan function between the 2D exposure and the 
3D scan.

If, during a tomosynthesis examination using the function 2D + Tomo-Scan, an 
error message appears for the following setting: 
- kV value: 32 kV 
- mAs value: > 280 mAs

Reduce the mAs value (< 280 mAs) in order to continue the examination.

Please note the following settings in order to avoid error messages:
23 - 28 kV < 300 mAs
29 - 32 kV < 280 mAs
33 - 35 kV < 250 mAs

Please note that customer uses 2D+Tomo-Scan as default for tomo proce-
dures. The function 2D + Tomo-Scan will be disabled automatically, when a 
tomo calibration will be performed.
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Ending the examination 0

u To end the examination, click this button in the Close Patient subtask card.

As soon as you have generated more than 3 series with the reconstruction 
parameters, the following message window will appear before you can close the 
examination:

u Click Yes.
– All series will be saved.

Or

u Click No.
– Switch to the Tomo subtask card, see section Deleting reconstructed 

images, to delete series.
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Tomosynthesis

Configuration

Configuring a tomo examination 0

Only the changes regarding the tomo examination are described here. For the 
configuration of the Examination task card see register Configuration, 
chapter Configuring examination.

Configuring procedures 0

You can create additional examination procedures and revise or delete existing 
procedures with the Procedures tab card.
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Reconstruction
parameters

You can select the reconstruction parameters configured by the system engineer.

u In the list of examination purposes, select Default RPG, e.g.
– Standard
– Calcification
– Phantom

Procedures provided as factory defaults 0

The following procedures are provided as factory defaults. You can use these pro-
cedures immediately for your examinations or use them as a template for addi-
tional new procedures you create. 

Tomo:

Examination purpose: Diagnosis (as default)

Referenced Operating Programs: AEC Tomo (as default)

Projection View set: TOMO R-CC, TOMO L-CC,
TOMO R-MLO, TOMO L-MLO

QC-raw Tomo:

Examination purpose: Phantom (for quality assurance)

Referenced Operating Programs: Calibration-raw tomo (as default)

Projection View set: TOMO R-CC, TOMO R-CC,TOMO R-CC
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Details of the projection views 0

In the course of an examination procedure different projection views are acquired 
in a defined sequence. You can determine the composition and sequence of the 
projection views in the PVS Dialog.

u Click Modify PVS.
– The PVS Dialog dialog box opens.

Modifying projection
views

u Click the Modify PVs tab into the foreground.
.

u Click the Single option.
– Only a single exposure (2D exposures) is selected.

u Click the Scan option.
– When a projection view is selected, the corresponding tomo exposures 

(3D exposures) are entered automatically (e.g. Tomo R-CC).

The projection views are defined in the Projection names subtask card.
A list of available projection views is shown in the Modify PVs and 
Modify PAOs dialog.
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Configuring OPDOSE programs 0

In the OPDOSE Programs tab card, you can specify the parameters for the 
exposure technique that uses the OPDOSE mode.

Examination type

u Select an examination type from the list.
– The individual values in the List of OPDOSE Programs are adjusted to the 

selected examination type.
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Image selection for autotransfer destinations 0

In the WH AWS Transfer Configuration configuration dialog you define which 
image material from the examination should be transmitted automatically to the 
individual destination addresses. You differentiate in this case according to image 
type and examination purpose of the images.

Image type u Select the image type that is to be sent to the selected destination address.
– Single Images for processing

only individual raw data (suitable for image processing/CAD server); 
correspond to 2D images

– Single Images for presentation
only single processed images (suitable for reporting station, for example); 
correspond to 2D images

– First View for processing 
only raw data of the first exposure or 2D exposure (suitable for the 
special 2D + Tomo-Scan mode)

– First View for presentation
only finished image of the first exposure or 2D exposure (suitable for the 
special 2D + Tomo-Scan mode)

– Tomo projections for processing
raw data set of the 25 projections

– Tomo projections for presentation
processed data set of the 25 projections

– Slices for presentation
reconstructed slices (suitable for reporting station, for example)



For notes

Tomosynthesis
Configuration

Operator Manual
54 / 56 XPW7-330.621.53.01.24



MAMMOMAT Inspiration
XPW7-330.621.53.01.24 55 / 56

Tomosynthesis

Technical Description

Identification Labels 0

The labels shown below are attached permanently to the corresponding locations 
of the following components of the X-ray stand.

Overall system 0

(1) Supplementary label

(2) UDI label Tomosynthesis Option

Workstation 0

(1) UDI label Tomosynthesis Option

(1), (2)

(1)
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Addendum to MAMMOMAT Inspiration 
Tomosynthesis Option

Physician Labeling 0

This section provides a brief summary of the physical laboratory testing results, 
including graphs and tables as appropriate. 

Manufacturer Contact Information 0

Siemens Medical Solutions USA, Inc.
51 Valley Stream Parkway
Malvern, PA 19355
USA

+1 (610) 219-9066
Technical Support
+1-800-888-7436

Prescription Use Statement 0

Federal law restricts this device to sale by or on order of a physician.

Indication for Use Statement 0

The MAMMOMAT Inspiration with Tomosynthesis Option is indicated for acqui-
sition of 2D as well as 3D digital mammography images to be used in screening 
and diagnosis of breast cancer.

Each screening examination may consist of CC and MLO views in:
– a 2D image set or
– a 2D and 3D image set.

Note:

The screening examination may consist of 2D FFDM images set with or without 
the 3D image set.
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Warnings / Cautions / Contraindications 0

Detector Calibration 0

Calibration unsuccessful

The following warning window appears when the calibration is unsuccessful:

This message means that several non-functioning pixels were found during the 
calibration. This requires a system check by a Siemens service technician. The re-
sults are available in the Service menu, see the Check calibration results section 
in the operator manual.

u Call a Siemens service technician or a technician trained by Siemens.

Cautions 0

Warning

The patient's head can enter the beam path.

Unnecessary radiation exposure!

u Make sure that the special face shield is always used during a tomosynthesis 
examination if there is a risk that the patient's head can enter the beam path.

Caution

Danger due to unintended release of pressure.

Risk of injury during release of pressure!

u Move the foot switches outside the reach of the patient and personnel as 
soon as the patient's breast is compressed.
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Contraindications 0

There are no known contraindications

Caution

If breast implants are not taken into consideration, this will lead to errors in treat-
ment and incorrect settings during the examination.

Risk of injury during compression and tomosynthesis examination!

u Ask the patient about existing implants prior to the examination. Inform the 
patient about the risks of providing false information.

u Adjust the preparation and examination of the patient accordingly (e.g., per-
forming compression, system parameter settings).

Caution

Swivel arm stops during exposure.

Unnecessary radiation exposure!

u Release the exposure on button.

u Turn the control knob upward for manual release of compression, or perform 
release of compression using the control panel or foot pedal.

Caution

If the wrong breast side or an unintended view was acquired, the image will be 
saved under an incorrect projection view.

Incorrect diagnosis or incorrect treatment possible!

u Check that the correct projection view is assigned to the image and correct 
it if necessary.

Caution

Swivel arm movements can cause parts of the body to be touched or crushed.

Risk of injury!

u Ensure that the patient is positioned correctly.

u Please note that the face shield also moves when the swivel arm moves.
The patient's head must not lean against the face shield while the swivel arm 
is moving.
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Device Description of Siemens Breast Tomosynthesis 0

The MAMMOMAT Inspiration is a Full Field Digital Mammography (FFDM) sys-
tem. The Mammography system stand provides a height-adjustable swivel arm 
with tube housing assembly and collimator on the upper end and an object table 
with FFDM detector on the lower end. The swivel arm can be angulated to the 
left and right for angulated image projections. This angulation feature is also used 
for the Tomosynthesis procedure. The X-ray generator and tube hardware are un-
changed compared to the 2D system. The compression system is unchanged but 
is provided with compression plates specific for the tomosynthesis application. 
The detector technology for the tomosynthesis mode (3D) remains the same as 
for 2D mammography which is an amorphous selenium-based direct conversion 
DR detector. The solid-state sensor is designed to have the required image qual-
ity and resolution characteristics making it suitable for mammography imaging. 
The sensor, control electronics, and power supply are integrated in the detector 
enclosure. This enclosure is designed to be mechanically integrated in a mam-
mography support device. It includes a high quality thin carbon cover window to 
protect the sensor active area. Temperature control of the detector is done by in-
tegrated fan cooling in the detector enclosure. 

The workflow for the Breast Tomosynthesis (DBT) procedure is similar to that of 
a Digital Mammography (DM). The breast is compressed on the mammography 
support device. 

In tomosynthesis mode the Siemens MAMMOMAT Inspiration acquires 25 im-
ages with short X-ray pulses over an angular range of 50°. A filtered back projec-
tion algorithm is applied to the projections to produce an initial reconstruction. 
Specific algorithms are used to reduce artifacts and image blurring. The result is 
an image data set of the entire breast volume.

The DBT processing is done in the acquisition workstation provided with the 
Mammography stand. The acquisition workstation features a preview image dis-
play to check the completeness of the examination. This image display is not for 
image diagnosis. The processed DBT image data can be sent to mammography 
viewing station capable for 3D image display such as the syngo MammoReport 
(K042868) or syngo.BreastCare (K123420) or any other PACS workstation cleared 
for breast tomosynthesis (PACS = Picture Archiving and Communication Sys-
tem).
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Differences between the Device used in the clinical trial 
and the Marketed Device 0

Siemens conducted the MRMC study with an investigational MAMMOMAT In-
spiration with tomosynthesis option. The differences between the investigational 
device and the marketed device are.

o The X-ray detector has been updated since the investigation. Comparative 
studies did confirm that performance and image quality are equivalent.

o The acquisition workstation comprises a newer computer generation as com-
pared to the investigational device. There is no impact on the safety and ef-
fectiveness of the MAMMOMAT Inspiration.

o For the MRMC reader study, the raw image data were processed with new 
reconstruction algorithms.

Non-Clinical Testing 0

Summary of Image Quality Testing 0

Siemens conducted testing to demonstrate the imaging performance of the 
MAMMOMAT Inspiration system. The following 3D performance tests are sum-
marized in this section:

1. Sensitometric Response

2. Modulation Transfer Function

3. Noise Power Spectrum

4. Detective Quantum Efficiency

5. Lag Test

6. Slice Sensitivity profiles

7. ACR phantom image quality

8. Uniformity in reconstructed slices

9. Geometric Accuracy

10. Visual In-Plane Resolution

11. Average Glandular Dose
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1. Sensitometric response of imaging detector in tomosynthesis mode

The purpose of this test is to demonstrate how the imaging detector responds to 
radiation exposure. The detector was exposed to radiation ranging between 
2 μGy and 90 μGy. The detector output responded linear (0.999990) to this radi-
ation exposure range.

2. Modulation transfer function (MTF)

The purpose of this test is to describe the spatial resolution of the detector. An 
edge phantom was placed on the mammography table in two orthogonal direc-
tions to evaluate the spatial resolution in two directions (horizontal and vertical). 
The results are listed in the following table and show that the detector can record 
details smaller than 0.1 mm. It was also observed that there is a difference in the 
spatial resolution power.

Table 1: MTF

3. Noise power spectrum (NPS)

The purpose of this test is to evaluate the noise response of the imaging detector 
versus the spatial resolution and radiation exposure. The results show the pixel 
noise variance responses in linear manner to the incoming air kerma. The conclu-
sion is that neither electronic noise nor fixed pattern noise plays a significant role 
in the imaging detector.

4. Detective quantum efficiency (DQE)

The purpose of this test is to describe the efficiency of signal-to-noise transfer of 
the image system. The measure is obtained by calculating the detective quantum 
efficiency as a function of the spatial frequency for several levels of radiation ex-
posure. The DQE values recorded show almost no dependence on the input air 
kerma in the range between 8 μGy and 90 μGy. For oblique irradiation (25° for to-
mo) the DQE values are about 10% lower than compared to the orthogonal irra-
diation used for 2D imaging.
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5. Lag test

The purpose of this test is to assess the appearance of residual image intensity 
from irradiations in the past on the time scale of a tomosynthesis image acquisi-
tion. 

Image acquisition and analysis was performed by applying a single exposure and 
analyzing the image intensity thereafter in equal time steps 1 to 12.

It was found that the residual image intensity after the first time step was about 
2% for step 2 to 12 less than 1%. The conclusion is that temporal effects have a 
very small impact on the clinical image.

6. Slice sensitivity profiles

The purpose of this test is to obtain quantitative data on the spatial resolution 
power perpendicular to the slices inside the reconstructed Tomosynthesis vol-
ume.

An ACR phantom was placed upon PMMA plates in order to achieve height po-
sitions of either 10 mm, 30 mm or 50 mm. The visibility of structures in the ACR 
(American College of Radiology) phantom was evaluated in the 3 different height 
positions. There was no noticeable deviation between variable object height po-
sitions.

7. ACR phantom image quality

The purpose of this test is to evaluate images from the ACR phantom. All tomo-
synthesis scans were generated under automatic compression and automatic ex-
posure control using a primary X-ray spectrum from the W anode with a tube 
voltage of 28 kV and 0.05 mm Rh inherent filtering. The thickness of the recon-
structed slices was 1 mm in all cases.

Reconstructed images from the ACR phantom are recorded and assessed after-
wards by a group of experienced human observers.

The following table summarizes the results achieved.

8. Uniformity in reconstructed slices

From reconstructed Tomosynthesis volumes of a spatially homogeneous PMMA 
block the achieved grayscale uniformity inside individual slices is assessed by 
comparing slice by slice the mean pixel values in several regions-of-interest. The 
detected non-uniformities fall in the range 5 % and lower.
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9. Geometric accuracy

The purpose of this test is to assess the fidelity in the mapping of geometrical 
length inside individual slices. The test phantom insert measured 79.9 mm in hor-
izontal and 79.7 mm in vertical direction. 

The results did not show significant variation of the detected object sizes with 
varying height position inside the reconstructed volume. The measured phantom 
sizes fit together on a length scale well below 0.1 mm.

10. Visual limiting resolution in tomosynthesis plane

The purpose of this test is to assess the visual spatial resolution in the recon-
structed image of a bar pattern phantom in variable height positions. The phan-
tom was put upon PMMA plates in order to achieve height positions of either
10 mm, 30 mm, or 50 mm.

The main result was that there is only a small dependence of the achieved results 
with the phantom height position in the sense that greater distance to the detec-
tor reduces recognizability.

11. Average glandular dose

The purpose of this test is to provide a quantitative estimate of the Average Glan-
dular Dose delivered during a full tomosynthesis scan of piles of PMMA plates of 
variable height. Several tube voltage settings in the typical range are applied. The 
following table provides a summary of the achieved results.

Table 2: AGD

The Clinical Study Summary will provide more evidence about the dose used in 
the study.
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Clinical Study Summary 0

An image collection study was conducted to support various MRMC reader stud-
ies, the first of which was to test the superiority of the Inspiration DBT system 
as an adjunct to FFDM vs. FFDM alone.

The primary purpose of the collection study was to collect FFDM and DBT imag-
es in order to conduct a reader study in support of the Inspiration DBT system. 
The reader study was a Multi-Reader, Multi-Case (MRMC) Receiver Operating 
Characteristic (ROC) study with a primary objective to demonstrate safety and ef-
fectiveness of the system by showing its superiority with respect to the readers' 
ability to detect and diagnose malignant lesions when used as an adjunct to 
FFDM in comparison to FFDM alone. 

Image Collection Study 0

This was a prospective, multi-center; non-randomized image collection study con-
ducted at seven (7) clinical sites in the US under an IRB approved protocol 
through a written consent process. FFDM images were acquired on any commer-
cially available FFDM system and the DBT images were acquired on the investi-
gational Inspiration DBT system. Subjects were enrolled prior to screening, or 
prior to diagnostic work-up or biopsy procedures. All subjects consented to a 
4-view DBT examination on the Inspiration DBT system in addition to a 4-view 
FFDM examination obtained as part of standard care. 

1. Inclusion/Exclusion Criteria for the study

Inclusion Criteria Subjects must have met the following overall criteria: 

o Female over 40, or 30 or older presenting for a biopsy

o A mammogram read as BI-RADS 0, 1,2,3,4 or 5 with applicable reports

Exclusion Criteria Subjects meeting any of the following criteria were not enrolled in the study: 

o Pregnant women or women who believe they may be pregnant or are trying 
to become pregnant

o Mastectomy patients

o Subjects who have had lumpectomy (cancer) ≤ 5 years prior to the study entry

o Inmates (in accordance with 45 CFR 46.306) or mentally disabled individuals

o BI-RADS Category 6

o BI-RADS® Category 4 or 5 without confirming pathology reports will be con-
sidered incomplete

o Subjects with mammograms that lack the required views

o Subjects being accrued from the screening population who know that they 
will not be in the United States or available for follow up mammograms in one 
year.
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2. Follow-up schedule

Individual participation in the study was limited to FFDM screening, or screening 
and diagnostic mammography examinations and any associated biopsy proce-
dures, if applicable. In addition at study entry a DBT scan was performed during 
any of the above listed visits, or on a scheduled day. Depending on the results of 
the overall examination at study entry, the study required a follow-up examination 
in either six (6) or twelve (12) months from all study subjects except subjects di-
agnosed with malignancy. The follow-up confirmed the subject non-cancer status 
in 6 or 12 months based on FFDM examination only. Therefore individual subject 
participation in the study lasted a minimum of 6 to 12 months for non-cancer sub-
jects, and from enrollment to malignancy diagnosis for subjects with cancerous 
lesion(s).

Average Glandular Dose distribution of subjects enrolled

The patient dose applied for the 300 subjects used for the tomo reader study 
have been collected and evaluated. The following figure provides a graphical rep-
resentation of the AGD for different breast thickness ranges.

Figure 1: AGD versus breast thickness

3. Adverse Events 

One Adverse Event and one Serious Adverse Event were recorded in the study 
and are described below.

3.a Serious Adverse Event

One subject was enrolled in the study in May 2011. While the Study Coordinator 
was reviewing a list of subjects whose yearly follow up had passed or was ap-
proaching, she was notified that the subject had passed away from pneumonia 
in July 2012. The subject did not complete her follow-up and was classified as 
"lost to follow up". The SAE was not device related.

3.b Adverse Event

One subject was enrolled and the day after undergoing DBT the subject called 
the site complaining about lightheadedness. It was determined that the AE was 
not related to the device.
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4. Accountability of the subject population

At the time of the MRMC Adjunct reader study being conducted, approximately 
700 subjects were enrolled into the image collection study. The collection study 
remained open and actively recruited potential subjects. Therefore only 338 sub-
jects out of the 700 enrolled were eligible to be selected for the MRMC Adjunct 
reader study. All subjects with 4 standard screening FFDM views and DBT imag-
es available to the sponsor were considered for selection. This group was further 
reduced by: 1) subjects with negative mammograms at baseline, but without 1 
year follow-up completed; 2) subjects whose follow-up was not negative; 3) sub-
jects whose images were not yet retrieved from the clinical sites, 4) subjects 
whose images were not yet quality checked and reprocessed; 5) subjects recent-
ly enrolled; 6) screen failures.

MRMC Reader Study Summary 0

1 Objective

The primary objective of this MRMC reader study was to test superiority of the 
DBT as an adjunct to FFDM with regards to readers' diagnostic accuracy in de-
tecting and characterizing breast lesions.

2 Study Endpoint

The primary endpoint was a comparison of the breast-level ROC areas, based on 
all subjects and all 22 readers, to evaluate the superiority of DBT as an adjunct 
to FFDM vs. FFDM alone.

3. Methods

300 FFDM and DBT images (50 cancers, 85 biopsy benign, 165 negative cases) 
from the eligible subjects were used in the MRMC reader study. The images 
were interpreted by twenty two (22) board certified radiologists, who had varying 
degrees of mammography experience and were blinded to any history data of the 
subjects. Readers were informed that the study is enriched with cancer cases.

Prior to the read all readers were trained on the basics of breast tomosynthesis 
and DBT image interpretation.

The images were randomized and read sequentially: FFDM followed by FFDM 
plus DBT MLO views, and FFDM plus 4-view DBT. The data entry order by the 
reader was 1) the assignment of a BI-RADS score at the breast level and if an ac-
tionable finding was identified, 2) type of finding, 3) a forced BI-RADS score and 
4) a Probability of Malignancy (POM) confidence score for each finding. The read-
ers recorded only the BI-RADS score for FFDM images read as negative and 
were not able to describe a finding if they assigned BI-RADS score of 1 or 2 to a 
breast. Any findings identified on FFDM were transferred to the FFDM DBT MLO 
and FFDM plus 4-view DBT reads to allow readers make adjustments in the 
BI-RADS and POM scores if needed based on the DBT read.
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Readers’ Probability of Malignancy (POM) confidence scores assigned to the can-
cerous lesions were used to estimate sensitivity. If a patient had multiple cancer-
ous lesions, then the highest (POM) confidence score was used. If a reader did 
not correctly locate any of the cancerous lesions, then a POM confidence score 
of zero was assigned. For estimating specificity, the highest POM confidence 
score assigned to any false positive finding was used; if there were no false pos-
itive findings, then a POM confidence score of zero was assigned. Analyses were 
performed at both the breast- and patient-level. 

The statistical analyses were based on 490 breasts out of the 600 breasts includ-
ed in the MRMC reader study. Per the MRMC Protocol all breasts included in the 
analyses required verification: either one year follow-up or biopsy. A detailed dia-
gram showing breast accountability of the 300 cases used in the MRMC reader 
study is presented below.
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4. MRMC Results

4.1 Primary analysis

The primary AUC endpoint of the study was met with statistically significant re-
sults showing superiority of DBT as an adjunct to FFDM. The ROC analysis 
showed that all readers while reading DBT in addition to FFDM improved their 
diagnostic accuracy in diagnosing and detecting cancer. For a breast-level ROC 
analysis, the readers’ mean ROC area with FFDM plus 4-view DBT was 0.853 
(Standard Error=0.027), which was significantly greater than the readers’ mean 
ROC area with FFDM only of 0.752 (SE=0.028).

Figure 2: Readers' estimated breast-level AUC with FFDM alone (blue) and their improvement with 
4-view DBT (red). Readers were sorted from lowest AUC on FFDM alone to highest.

4.2 Secondary analyses 

Seven secondary analyses were performed and the results of these are present-
ed below. The readers’ parametric and nonparametric estimates of the patient-
level ROC curve areas comparing FFDM alone with FFDM plus 4-view DBT also 
showed significant improvement with DBT. The readers’ mean ROC area with 
FFDM only was 0.687 (SE=0.040), which improved significantly to 0.829 
(SE=0.039) with FFDM plus 4-view DBT for the parametric measures and the 
readers’ mean ROC area with FFDM was 0.709 (SE=0.033) and with FFDM plus 
4-view DBT was 0.831 (SE=0.032) for the non-parametric measures. We ob-
served an increase in diagnostic accuracy for patients with dense breasts, fatty 
breasts, microcalcifications, and masses in our MRMC study; however the statis-
tical significance of these findings was not assessed.
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For 18 of the 22 readers, their non-cancer recall rate was lower for DBT as an ad-
junct to FFDM than for FFDM alone. For 12 of the 18 readers, the decrease in 
recall rate was statistically significant. Overall, the readers’ mean recall rate with 
FFDM alone was 0.438 (SE=0.030) and with FFDM plus 4-view DBT was 0.355 
(SE=0.022), which is a statistically significant reduction.

The readers’ mean sensitivities and specificities are summarized in Table 3. In the 
MRMC study we observed that readers’ mean sensitivity with 4-view DBT was 
superior to readers’ mean sensitivity with FFDM only; however the statistical sig-
nificance of these findings was no assessed.

Table 3: Estimates of Sensitivity and Specificity
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We observed in our study through the ROC analysis that the average diagnostic 
accuracy of radiologists is superior with FFDM plus DBT MLO than with FFDM 
alone. The statistical significance of this finding was not assessed.

The summary ROC curves, derived from the parametric estimates, are shown in 
Figure 3.The readers’ mean ROC area with FFDM only was 0.687 (SE=0.040), 
which improved significantly to 0.829 (SE=0.039) with FFDM plus 4-view DBT.

Figure 3: Summary ROC curves for FFDM (blue dashed) and FFDM plus 4-view DBT (red solid).
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Conclusions Drawn from the Studies 0

o Siemens conducted an MRMC study with 22 readers having a broad range of
experience. All readers improved their accuracy in detecting and diagnosing
cancers when reading DBT as an adjunct to FFDM.

In that study, when readers used Siemens Tomosynthesis as an adjunct to 
FFDM, on average
– diagnostic accuracy (measured by the AUC ROC) in screening mammogra-

phy increased,
– cancer detection rate increased,
– identification of lesions that were ultimately proven to be malignant

increased,
– non-cancer recall rate was reduced,
– patient recall rate was reduced, 

– sensitivity in the detection of cancer in the patients with dense and fatty
breasts increased.

o Siemens DBT as an adjunct to FFDM has been shown to reduce the non-can-
cer recall rate compared with FFDM alone.

o Siemens Tomosynthesis solution in adjunct to FFDM has been shown to im-
prove diagnostic accuracy in screening mammography compared with FFDM
alone.

o In the pivotal study, reader sensitivity on average was greater for readings
based on 4- view DBT as an adjunct to FFDM than for readings based on
FFDM alone.

o In the pivotal study, reader’s patient-level AUC on average was greater for
readings based on 4-view DBT (MLO+CC) as an adjunct to FFDM than for
readings based on FFDM alone (AUC difference 0.1408, standard error
0.0386).

o In the pivotal study, reader’s patient-level AUC on average was greater for
readings based on 2-view DBT (MLO) as an adjunct to FFDM than for readings
based on FFDM alone (AUC difference 0.095, standard error 0.033).

o The benefit of additional 4-view DBT exam outweighs the increased risk from
the additional radiation dose as shown in the Siemens MRMC study.
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